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ADL SCORM 2004 RELOAD Editor  

Introduction 

The ADL SCORM 2004 RELOAD Editor is a content package and metadata editor. With 
RELOAD Editor, you can create, import, edit, and export SCORM-conformant content packages. 
With ADL SCORM 2004 RELOAD Editor you can create SCORM 1.2 and SCORM 2004 3rd and 
4th Edition content packages.  
 

For RELOAD Editor legacy information and additional help, see the RELOAD help files. 

Installation 

Prerequisites 

IMPORTANT: Read ALL of the installation Instructions BEFORE beginning installation. 
 
This release of the RELOAD Editor requires the Java Development Kit (JDK) from any one of the 
following Java versions:  

• Java SE 6, Updates 1 through 7 *  



• J2SE 5.0, Update 10 or later  

The latest version of this software can be downloaded free of charge at 
http://java.sun.com/javase/downloads/index.jsp. Archived versions are available at 
http://java.sun.com/products/archive/. Refer to this site for a list of specific Java versions 
verified.  

Notes:  

• RELOAD may run on old or new releases of the Java environment. RELOAD was 
tested on Java SE 6.  

After installing the Java Development Kit, you must:  

1. Create an environment variable named "JAVA_HOME" and set its value to the root 
directory of the Java Development Kit.  

o For Windows XP: Right click "My Computer", select "Properties", select the 
"Advanced" tab and then click "Environment Variables". Add a JAVA_HOME 
entry in the User or System Variables that points to the location where you 
installed the Java Development Kit.  

o For Windows Vista: Open the "Start" menu and right click "Computer", select 
"Properties", select the "Advanced System Settings" link on the left navigation 
menu, and then click Environment Variables. Add a JAVA_HOME entry in the 
User or System Variables that points to the location where you installed the Java 
Development Kit. 

2. Add the full path of the Java Development Kit bin directory (where the java.exe is located) 
to the PATH environment variable.  

o For Windows XP: Right click "My Computer", select "Properties", select the 
"Advanced" tab and then click "Environment Variables". Add the Java 
Development Kit bin directory to the Path by adding a semicolon followed by a 
reference to the JAVA_HOME environment variable followed by "\bin" 
(i.e., %JAVA_HOME%\bin).  

o For Windows Vista: Open the "Start" menu and right click "Computer", select 
"Properties", select the "Advanced System Settings" link on the left navigation 
menu, and then click Environment Variables. Add the Java Development Kit bin 
directory to the Path by adding a semicolon followed by a reference to the 
JAVA_HOME environment variable followed by "\bin" (i.e., %JAVA_HOME%\bin).  

Constraints 

ADL tested RELOAD on the Intel® Pentium® PC platform running Microsoft® Windows® Vista SP1 
and XP Professional SP3 for this release.  

Installation 

IMPORTANT: Only install RELOAD after installing the Java Development Kit as described 
in the Prerequisites.  

RELOAD is available for download as a zip file. After you finish downloading the file: 

1. Extract the zip file to a location on your PC.  

2. Double-click on the ADL_SCORM_2004_RELOAD_1_1.jar executable jar file.  



Uninstalling RELOAD 

Delete the directory housing the RELOAD zip file to erase all RELOAD code. 

 

Revisions 

Changes from ADL SCORM 2004 RELOAD Version 1.0 to ADL SCORM 2004 RELOAD 
Version 1.1 

• RELOAD integrates this new functionality:  

o SCORM 2004 4th Edition Sample Run-Time Environment (SRTE) Version 1.1.1: 
if the SRTE is installed on a user’s machine, a RELOAD package can be 
automatically imported using the RTE Package View menu option.  

o SCORM Learner Assessment Generator (SLAG): the user can add a SLAG 
exam by right clicking the resources node and by choosing "Add Quiz".  

o Healthcare LOM metadata support  

• RELOAD includes these enhancements:  

o Human readable manifest  

o Forced ".zip" file extension when zipping a content package 

o Support additional character encodings 

Changes from RELOAD Version 1.3.2 to ADL SCORM 2004 RELOAD Editor Version 1.0 

• RELOAD includes these updates based on the SCORM 2004 4th Edition release: 

o Changes top level metadata <schemaversion> value to "2004 4th Edition"  

o Updated <adlcp:completionThreshold> element  

o Included ability to add the <adlcp:completionThreshold> element under the 
<organization> element  

o Added the <adlcp:sharedDataGlobalToSystem> attribute to the <organization> 
element  

o Added the <adlcp:data>  and <adlseq:objectives> elements  

o Added the <adlnav:hideLMSUI> element to the sequencing and navigation 
wizard  

o Added manifest validation for SCORM 2004 4th Edition packages  

o Updated ADL, IMS and IEEE schemas 

• ADL Registry Metadata support includes 

o A new form with ADL Registry metadata mandatory fields  

o ADL Registry Metadata validation  

o LOM schemas with the ADL Registry extension vocabularies 

 

Running RELOAD  

Instructions 



Use these instructions to run RELOAD on a Windows platform. RELOAD was only tested on the 
Windows platform and is the only platform for which instructions have been provided.  

To run RELOAD:  

1. Double click the ADL_SCORM_2004_RELOAD_Editor_1_1.jar file to launch the 
RELOAD application.  

2. Use the File menu to open an existing package or create a new package. You can also 
create a SCORM 2004 4th Edition package using the LSAL templates via the File menu.  

Use the Help menu if you need assistance.  

File Menu - Contains standard file action options and some RELOAD-specific actions. File Menu 
actions include:  

• New - Allows users to create a new IMS Metadata file, a new LOM Metadata file or a new 
SCORM Content Package.  

o IMS 1.2.2 Metadata File - Create a new stand-alone IMS Metadata file  

o LOM 1.0 Metadata File - Create a new stand-alone LOM Metadata file  

o ADL-R Metadata File - Create a new stand-alone ADL-R Metadata file  

o Healthcare LOM Metadata File - Create a new stand-alone Healthcare LOM 
Metadata file  

o ADL SCORM 1.2 Package - Create a new SCORM Version 1.2 Package  

o ADL SCORM 2004 3rd Ed. Package - Create a new SCORM 2004 3rd Edition 
Package  

o ADL SCORM 2004 4th Ed. Package - Create a new SCORM 2004 4th Edition 
Package  

o ADL SCORM 2004 Package from Template - Create a new SCORM 2004 
Package using a predefined template. See ADL Guidelines for Creating 
Reusable Content with SCORM 2004 at www.ADLNet.gov for details about the 
SCORM templates and SCORM packages in general.  

• Open - Allows users to open existing IMS or SCORM content packages.  

• Import Resources - Allows users to import new resources into a content package from 
anywhere on their computer/system. The menu item brings up a file chooser dialog box 
and enables the user to navigate to the content of their choice. After identifying content, 
the file(s) are copied to the working directory of the current content package. You can 
add entire directories this way. If users choose to import an individual file, they may also 
choose to check the checkbox, 'Include dependent Files', which ensures that any 
associated images or style sheets are also copied into the content package working 
directory.  

• Save - Allows the users to save the information for their current content package.  

• Save As - Allows the users to save the information for their current content package with 
a new name.  

• Zip Content Package - Allows users to save their current content package.  

• Convert 1.2 > 2004 - The conversion functionality was disabled in this version of 
RELOAD. It may be enabled in a future ADL RELOAD release.  

• Convert to SCORM 2004 4th Edition - Allows users to convert SCORM 2004 3rd 
Edition packages to SCORM 2004 4th Edition packages. Note: This does not include run-
time updates.  



• Recent Files - Provides access to the last four recently edited content packages.  

• Exit - Quits RELOAD. You will be prompted to save any unsaved work.  

Edit Menu - Contains the standard edit action options as well as some specific actions relevant to 
RELOAD Editor. Edit Menu actions include:  

• Undo - Allows users to undo the last action  

• Redo - Allows users to redo the last action 

• Cut - Allows users to cut the current selection (into the clipboard). This option works for 
both files and text.  

• Copy - Allows users to copy the current selection (into the clipboard). This option works 
for both files and text.  

• Paste - Allows users to paste the contents of the clipboard into the current position. This 
option works for both files and text.  

• Delete - Allows users to delete the current selection. This option works for both files and 
text.  

• Move Up - Allows users to move the selected file UP within the content package 

• Move Down - Allows users to move the selected file DOWN within the content package 

• Context Sensitive Items - The remainder of this menu contains context sensitive items. 
The menu is generated dynamically based on the node selected in the content package 
tree view. For example, if you select an item, the Sequencing Editor is available with the 
Edit Sequencing Menu Item.  

Debug Menu - Provides the ability to view the schemas for metadata and manifest files. You can 
also access validation functionality via the Debug Menu. The following list details the schemas 
that can be viewed. In addition, the Validate SCORM 2004 4th Edition Manifest menu item 
validates the manifest file in accordance with the SCORM 2004 4th Edition Application Profiles:  

• IMS Metadata 1.2.1 Schema  

• IMS Metadata 1.2.2 Schema  

• LOM Metadata 1.0 Schema  

• IMS Content Packaging 1.1.2 Schema  

• IMS Content Packaging 1.1.3 Schema  

• ADL SCORM 1.2 Schema  

• ADL SCORM 2004 3rd Edition Schema  

• ADL SCORM 2004 4th Edition Schema  

• Validate SCORM 2004 4th Edition Manifest  

• IMS Simple Sequencing 1.0 Schema  

Options Menu - Contains RELOAD preferences and look and feel options. Options Menu actions 
include:  

• Preferences - Consists of 3 tabbed windows. Specifically, General, Content Packager 
and Metadata Editor tabs are available.  

• Look and Feel - Allows users to choose the overall look of the RELOAD Editor software.  



View Menu - Contains specific options to allow users to view their content package. View Menu 
actions include:  

• View File - Allows users to view any file within the package in a web browser.  

• Preview Content Package - Allows users to preview the whole content package in a 
web browser.  

• RTE Package View - Imports the package into the SCORM 2004 4th Edition Sample 
Run-Time Environment (SRTE) Version 1.1.1 available at www.ADLNet.gov. To use this 
menu option, the SRTE must be installed on the same PC as the RELOAD Editor.  

• Status Window - Allows users to choose to display or hide the Java status window. Any 
informational Java messages are displayed there and may be useful if you discover a 
bug in the software.  

Note: There is no API instance in RELOAD when you view a file using the View File or Preview 
Content Package menu options listed above. If you launch a SCO, it will not find an API instance. 
This may result in unexpected behaviors. ADL recommends testing your package in the latest 
SCORM 2004 Test Suite. You can also view sequencing and additional run-time behaviors by 
downloading and running the SCORM Sample Run-Time Environment (SRTE). The Test Suite 
and SRTE are available at www.ADLNet.gov  

Window Menu - Provides a list of currently open files (content packages) and provides options 
for how these open windows are arranged on the screen. Window Menu actions include:  

• Cascade - Allows users to organize open windows into a cascade pattern for easy on 
screen navigation 

• Tile Horizontally - Allows users to tile windows down the screen for easy comparison 

• Tile Vertically - Allows users to tile windows across the screen for easy comparison 

• Dynamic Open File Item(s) - Displays a list of open files or packages at the bottom of 
the Window Menu 

Help Menu - Provides access to RELOAD help and about content. Help Menu actions include:  

• Help - Available by choosing this menu item, or by pressing F1 

• About ADL SCORM 2004 RELOAD Editor – Provides details about the RELOAD Editor 
software, including contributors, copyright and contact information. It is also the easiest 
place to find out the version number and date of RELOAD Editor. 

RELOAD Design Information  

RELOAD was built as an open source project on SourceForge. For information on the original 
design and accompanying documentation, see http://www.reload.ac.uk.  

Older versions of RELOAD are available on SourceForge at 
http://sourceforge.net/scm/?type=cvs&group_id=76357. Source files for this version of 
RELOAD are currently only available as part of the downloaded zip file. A future version will be 
integrated into the SourceForge baseline.  

RELOAD is a Java application with a Swing GUI. Many 3rd party components are used where 
applicable. JavaDoc documentation is available in all RELOAD source as well as 3rd party 
components. RELOAD source is available in the src directory. Java Ant build files are available in 
the src\make directory.  



 

Additional Information  

Known Issues  

1. ADL replaced the LOM schemas with the extended ADL Registry schemas for validation 
purposes. LOM metadata manually edited to contain ADL Registry extension 
vocabularies will validate.  

2. ADL disabled the File > Convert 1.2 to 2004 menu option. This option will be enabled 
when the conversion code has been updated to SCORM 2004 4th Edition 

Implementation Decisions 

Supported Java Versions  

• These Java Development Kit versions were tested with RELOAD:  

o Java SE 6, any update level  

o J2SE 5.0, Update 10 or later 

System Requirements 

• Minimum System Requirements for RELOAD operation:  

o Windows XP or Windows Vista  

o 2 GHz Processor  

o 1 GB of RAM  

o 50 MB of free disk space  

 

• Recommended System Requirements for RELOAD operation:  

o Windows XP or Windows Vista  

o 4 GHz Processor  

o 2 GB of RAM  

o 60 MB of free disk space  

Licenses and Copyrights  

RELOAD Editor - An IMS Metadata, Content Packaging and Learning Design tool  
 
Copyright (c) 1998-2009 Oleg Liber, Bill Olivier, Phillip Beauvoir  
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, 
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do 
so, subject to the following conditions:  
 
The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.  
 



THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.  
 
Project Management Contact:  
 
Oleg Liber 
Bolton Institute of Higher Education 
Deane Road 
Bolton BL3 5AB 
UK 
 
 
e-mail: o.liber@bolton.ac.uk  
 
Technical Contact:  
 
Phillip Beauvoir 
e-mail: p.beauvoir@bolton.ac.uk 
 
 
Web: http://www.reload.ac.uk 

 


